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Chapter 7
Equations and Computation

This chapter describes how to define and evaluate variables and fu
tions. This chapter discusses only numerical equations. To learn ho
use Mathcad's symbolic processing features, turn to Chapter 17, “S
bolic Calculation.”

The following sections make up this chapter:

Defining variables and functions
How to define variables and functions. How the relative placement of eq
tions affects calculations.

Evaluating expressions
How to get a numerical answer.

Copying numerical results
How to copy numerical results from one worksheet to another or from 
Mathcad to other applications.

Controlling calculations
How to suppress the way Mathcad automatically updates the workshee

Disabling equations
Turning calculation or editing on and off for individual equations.

Error messages
What to do when Mathcad displays an error message.
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Defining variables and functions 

Whenever you type an equation into a worksheet, you are doing one of two thing

■ You could be typing an expression and asking Mathcad to give you the answ
This is discussed in the next section, “Evaluating expressions.”

■ You could be typing a variable or function name and assigning some value to
The remainder of this section discusses how to do this.

Defining a variable 

A variable definition defines the value of a variable everywhere below the definiti
To define a variable, you must follow these three steps:

■ Type the variable name to be defined. 
Chapter 8, “Variables and Constants,” 
contains a description of valid variable 
names.

■ Press the colon (: ) key. The definition 
symbol (:=) appears. 

■ Type an expression to complete the defi-
nition. This expression can include num-
bers and any previously defined variables 
and functions.

Figure 7-1 shows several examples of a variable definition. The left hand side of a:=” 
can contain any of the following:

■ A simple variable name like x.

■ A subscripted variable name like .

■ A matrix whose elements are any of the above. For example:

■ A function name with an argument list of simple variable names. For example
. This is described further in the next section.

■ A superscripted variable name like .

vi

x

y1

f x y z, ,( )

M
1〈 〉
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Figure 7-1: Defining variables.

Defining a function 

You can also define your own functions in Mathcad. Unlike a variable, the value 
function depends on the values of its arguments.

You define a function in much the same way you define a variable. The name go
the left, a “:=” goes in the middle, and an expression goes on the right. The main
difference is that the name includes an argument list. The example below shows how
to define a function called dist(x, y) which returns the distance between the point (x, y) 
and the origin.

To type such a function definition:

■ Type the function name. 

■ Type a left parenthesis followed by one or 
more names separated by commas. Com-
plete this argument list by typing a right 
parenthesis. 

It makes no difference whether or not the names in the argument list have been de
or used elsewhere in the worksheet. What is important is that these arguments must be 
names. They cannot be more complicated expressions. 

■ Press the colon (: ) key. You see the defi-
nition symbol (:=).
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■ Type an expression to define the function. 
In this example, the expression involves 
only the names in the argument list. In 
general though, the expression can con-
tain any previously defined functions and 
variables as well.

Once you have defined a function, you can use it anywhere below the definition,
as you would use a variable.

When you use a function in an equation, Mathcad:

■ evaluates the arguments you place between the parentheses, 

■ replaces the dummy arguments in the function definition with the actual argum
you place between the parentheses, 

■ performs whatever arithmetic is specified by the function definition, and

■ returns the result as the value of the function.

Figure 7-2 shows an example.

Figure 7-2: A user-defined function to compute the distance to the coordinate 
origin.

The arguments of a user function can represent scalars, vectors, or matrices. Fo
example, you could define the distance function as 

dist v( ) v0
2 v1

2+:=
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This is an example of a function that accepts a vector as an argument, and retur
scalar result. See the section “Arrays and user-defined functions” in Chapter 10 
more information. 

Note that function names are font sensitive. This means that the function f(x) is different 
from the function f(x). Figure 7-3 shows an example. 

Mathcad's built-in functions are defined for all fonts (except the Symbol font), siz
and styles. This means that sin(x), sin(x), and sin (x) all refer to the same function. 

Figure 7-3: Function names are font sensitive. Undefined variables are 
marked in reverse video.

Variables in user-defined functions 

When you define a function, you don't have to define any of the names in the argu
list. This is because when you define a function, you are telling Mathcad what to do 
with the arguments, not what they are. When you define a function, Mathcad doe
even have to know whether the arguments are scalars, vectors or matrices. All it 
to know is how many arguments there are and what to do with them. It is only w
Mathcad actually uses a function that it needs to know what the arguments really a

However, if in the process of defining a function you use a variable name that is not in 
the argument list, you must define that variable name above the function definitio
The value of that variable at the time you make the function definition then becom
permanent part of the function. This is illustrated in Figure 7-4.

When you evaluate a function, Mathcad:

■ evaluates the arguments, 
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■ substitutes their values on the right side of the function definition, 

■ evaluates the values of the other variables at the point where the function is defined, 

■ computes and returns a result.

If you want a function to depend on the value of a variable, you must include tha
variable as an argument. If not, Mathcad will just use that variable's fixed value a
point in the worksheet where the function is defined.

Figure 7-4: The value of a user function depends on its arguments.

Recursive function definitions

Mathcad supports recursive function definitions—you may define the value of a 
function in terms of a previous value of the function. As shown in Figure 7-5, recur
functions are useful for defining arbitrary periodic functions, as well as elegantly 
implementing numerical functions like the factorial function.

Note that a recursive function definition should always have at least two parts:

■ An initial condition that prevents the recursion from going forever.

■ A definition of the function in terms of some previous value(s) of the function.

If you do not specify an initial condition that stops the recursion, Mathcad will gene
a “stack overflow” error message as described in “Error messages” on page 154

Pro The programming operators in Mathcad Professional also support recursion. Se
section “Programs within programs” in Chapter 18 for examples.
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Figure 7-5: Mathcad allows recursive function definitions.

How Mathcad scans a worksheet 

Mathcad scans a worksheet the same way you read it: left to right and top to bot
This means that a variable or function definition involving a “:= ” affects everything 
below and to the right of it.

To determine whether one equation is above or below another, Mathcad compare
anchor points. To see these anchor points, choose Regions from the View menu. 
Mathcad will display blank space in gray and leave regions white (or whatever y
background color happens to be). Each region's anchor point will appear as a do
the left.

Figure 7-6 shows an example of how not to place equations in a worksheet. In the
evaluation, both x and y are shown in red to indicate that they are undefined. This 
because the definitions for x and y lie below where they are used. Because Mathcad
scans from top to bottom, when it gets to the first equation, it has no idea what num
to substitute in place of x and y.

The second evaluation, on the other hand, is below the definitions of x and y. By the 
time Mathcad gets to this equation, it has already assigned values to both x and y. 
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Figure 7-6: Mathcad evaluates equations from top to bottom in a worksheet. 
The small dot on the left side of each equation is an anchor point. Undefined 
variables are marked in reverse video.

You can define a variable twice in the same worksheet. Mathcad will simply use
first definition for all expressions below the first definition and above the second. 
expressions below the second definition, Mathcad uses the second definition. Fi
7-7 illustrates a worksheet in which some variables are defined twice.
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Figure 7-7: A worksheet in which V and T are both defined twice.

Global definitions 

Global definitions are exactly like local definitions except that they are evaluated bef
any local definitions. If you define a variable or function with a global definition, th
variable or function is available to all local definitions in your worksheet, regardle
of whether the local definition appears above or below the global definition.

To type a global definition, follow these steps:

■ Type a variable name or function to be 
defined.

■ Press the tilde (~) key. The global defini-
tion symbol appears.

■ Type an expression. The expression can 
involve numbers or other globally defined 
variables and functions.

You can use global definitions for functions, subscripted variables, and anything 
that normally uses the definition symbol “:=”. Just type a tilde instead of a colon, and
Mathcad will show the global definition symbol “≡” in place of “:=” .

This is the algorithm that Mathcad uses to evaluate all definitions, global and otherw

■ First, Mathcad takes one pass through the entire worksheet from top to botto
During this first pass, Mathcad evaluates global definitions only.
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■ Mathcad then makes a second pass through the worksheet from top to bottom
time, Mathcad evaluates all definitions made with “:=” as well as all equations 
containing “=”.

Figure 7-8 shows the results of a global definition for the variable R which appears at 
the bottom of the figure. 

Figure 7-8: Using the global definition.

Although global definitions are evaluated before any local definitions, Mathcad e
uates global definitions the same way it evaluates local definitions: top to bottom
left to right. This means that whenever you use a variable to the right of a “≡”:

■ that variable must also have been defined with a “≡,” and

■ the variable must have been defined above the place where you are trying to use i

Otherwise, the variable is marked in red to indicate that it is undefined.

It is good practice to allow only one definition for each global variable. Although y
can do things like define a variable with two different global definitions or with on
global and one local definition, this is never necessary and usually serves only to 
your worksheet difficult to understand.
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Evaluating expressions 

To evaluate an expression, follow these steps:

■ Type an expression containing any valid 
combination of numbers, variables and 
functions. Any variables or functions in 
this expression should be defined earlier 
in the worksheet.

■ Press the “=” key. Mathcad computes the 
value of the expression and shows it after 
the equals sign. 

Figure 7-9 shows some calculations using the definitions from Figure 7-1.

Figure 7-9: Calculations based on the variables defined in Figure 7-1.

Whenever you evaluate an expression, Mathcad shows a final placeholder at the
of the equation. You can use this placeholder for unit conversions, as explained 
Chapter 9, “Units and Dimensions.” As soon as you click outside the region, Math
hides the placeholder. 
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Copying numerical results

You can copy a numerical result and paste it either elsewhere in your worksheet o
another application. This allows you to copy an array of numbers directly from a 
spreadsheet or database into Mathcad where you can take advantage of its free
interface and its advanced mathematical tools, and vice versa. Once you've perfo
the necessary computations, you can paste the resulting array of numbers back to
it came from or even into another application. 

Copying a single number

To copy a single number appearing to the right of an equal sign:

■ Click on the result to the right of the equal sign. This puts the result between 
editing lines.

■ Choose Copy from the Edit  menu. This places the result on the clipboard.

■ Click wherever you want to paste the result. If you're pasting into another app
tion, choose Paste from that application's Edit  menu. If you're pasting into a 
Mathcad worksheet, choose Paste from Mathcad's Edit  menu.

The Copy command will copy the numerical result only to the precision displayed.
copy the result in greater precision, double-click on it and increase “Displayed P
sion” on the Number Format dialog box. Note that Copy will not copy units and 
dimensions from a numerical result.

When you paste a numerical result into a Mathcad worksheet, it appears as:

■ a math region consisting of a number if you paste it into empty space,

■ a text string if you paste it into a text,

■ a number if you paste it into a placeholder in a math region or if you paste it i
text using the Math Region command on the Insert menu.

Copying an array of numbers

To copy an array (vector or matrix) appearing to the right of an equal sign:

■ Click on the array to the right of the equal sign. This puts the array between t
editing lines.

■ Choose Copy from the Edit  menu. This places the array on the clipboard. 

■ Click wherever you want to paste the result. If you're pasting into another app
tion, choose Paste from that application's Edit  menu. If you're pasting into a 
Mathcad worksheet, choose Paste from Mathcad's Edit  menu.

When you paste an array into a Mathcad worksheet, it appears as:

■ a vector or matrix if you paste it into empty space,
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■ a text string if you paste it into text,

■ a vector or matrix if you paste it into a placeholder in a math region or if you pa
it into text using the Math Region command on the Insert menu.

The Copy command will copy the numerical result to the precision with which it is
displayed. You can view the current display settings by double-clicking on the re
you want to copy and examining the dialog box. See Chapter 6, “Equation and R
Formatting,” to learn more about formatting numbers for display. Note that Copy will 
not copy units and dimensions.

Copying numbers from a scrolling output table

When you display results in a scrolling output table as described in the section 
“Displaying vectors and matrices” in Chapter 10, you may want to copy some of 
numbers from the table and use them elsewhere.

To copy just one number from a scrolling output table, simply click on the number
choose Copy from the Edit  menu. To copy more than one number from a scrolling
output table:

■ Click on the first number you want to copy.

■ Drag the mouse in the direction of the other values you want to copy while hold
the mouse button down.

■ Choose Copy from the Edit  menu.

To copy all the values in a row or column, click on the column or row number sho
to the left of the row or at the top of the column. All the values in the row or colum
will be selected. Then choose Copy from the Edit  menu.

After you have copied one or more numbers from a scrolling output table, you can 
them into another part of your worksheet or into another application. Figure 7-10 sh
an example of a new matrix created by copying and pasting numbers from a scro
output table. Note that if you copied and pasted more than nine rows or columns
numbers from the table, they will be displayed as a new scrolling output table.
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Figure 7-10: Creating a new matrix from numbers in a scrolling output table.

Controlling calculations 

When you start Mathcad, you are in “automatic mode.” This means that Mathcad
updates results in the worksheet window automatically. You can tell you're in autom
mode because the word “Auto” appears in the message line.

If you don't want to wait for Mathcad to make computations as you edit, disable 
automatic mode by choosing Automatic Calculation from the Math  menu or by 
clicking the light bulb on the toolbar. The word “Auto” disappears from the messa
line and the checkmark beside Automatic Calculation disappears to indicate that 
automatic mode is now off.

Automatic window update 

The word “Auto” on the message line indicates that you are in automatic mode. 
means that:

■ As soon as you press the equals sign, Mathcad displays a result.

■ As soon as you click outside of an equation having a “:=” or a “≡, ” Mathcad 
performs all calculations necessary to make the assignment statement.

When you process a definition in automatic mode by clicking outside the equatio
region, this is what happens:
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■ Mathcad evaluates the expression on the right side of the definition and assig
to the name on the left.

■ Mathcad then takes note of all other equations in the worksheet that are in any
affected by the definition you just made.

■ Finally, Mathcad updates any of the affected equations that are currently visib
the worksheet window. 

Although the equation you altered may affect equations throughout your worksh
Mathcad performs only those calculations necessary to insure that whatever you
see in the window is up-to-date. This optimization makes sure you don't have to
for Mathcad to evaluate expressions that are not visible.

In automatic mode, if you print or move to the end of the worksheet, Mathcad 
automatically updates the whole worksheet.

Whenever Mathcad needs time to complete computations, the mouse pointer ch
its appearance and the word “WAIT” appears on the message line. This can occur wh
you enter or calculate an equation, when you scroll, during printing, or when you
enlarge a window to reveal additional equations. In all these cases, Mathcad eva
pending calculations from earlier changes.

As Mathcad evaluates an expression, it surrounds it with a green rectangle. This m
it easy to follow the progress of a calculation.

To force Mathcad to recalculate all equations throughout the worksheet, choose
Calculate Worksheet from the Math  menu.

Manual window update

In manual mode, Mathcad does not compute equations or display results until yo
specifically request it to recalculate. This means that you don't have to wait for Mat
to calculate as you enter equations or scroll around a worksheet.

Mathcad keeps track of pending computations while you're in manual mode. As 
as you make a change that requires computation, the word “Calc” appears on th
message line, as shown in Figure 7-11. This is to remind you that the results you
in the window are not up-to-date and that you must recalculate them before you c
sure they are updated. 
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Figure 7-11: The word “Calc” on the message line indicates that recalcula-
tion is required.

You can update the screen by choosing Calculate from the Math  menu. Mathcad 
performs whatever computations are necessary to update all results visible in th
worksheet window. When you move down to see more of the worksheet, the wo
“Calc” reappears on the message line to indicate that you must recalculate to se
to-date results.

To process the whole worksheet, including those portions not visible in the works
window, choose Calculate Worksheet from the Math  menu.

To switch back to automatic mode, choose Automatic Calculation from the Math  
menu. Mathcad updates the entire worksheet and displays the word “auto” on th
message line.

When you print a worksheet in manual calculation mode, the results on the printou
not necessarily up-to-date. When you're in manual mode, make sure to choose Calcu-
late Worksheet from the Math  menu before you print.

Interrupting calculations   

To interrupt a computation in progress:

■ Press [Esc ]. The dialog box shown below will appear.
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■ Click “OK” to stop the calculations or “Cancel” to resume calculations.

If you click “OK,” Mathcad displays a message on the message line to indicate th
processing has been interrupted. The equation that was being processed when 
pressed [Esc ] is marked with an error message indicating that calculation has be
interrupted. To resume an interrupted calculation, first click in the equation having
error message, then choose Calculate from the Math  menu.

If you find yourself frequently interrupting calculations to avoid having to wait for
Mathcad to recalculate as you edit your worksheet, you may wish to switch to ma
mode. To do so, disable automatic mode by choosing Automatic Calculation from the 
Math menu. This will remove the checkmark from the menu. In manual mode, Math
recalculates only when you choose Calculate from the Math  menu.

Starting in manual mode 

The calculation mode—either manual or automatic—is a property saved in your 
Mathcad worksheet. If you often work in manual calculation mode, simply save y
worksheets with Mathcad configured to work in manual mode; this way you do n
have to disable automatic calculation each time you open your worksheets. 

The calculation mode of Mathcad is also one of the properties saved in Mathcad
template (MCT) files. As described in Chapter 4, “Worksheet Management,” you u
Mathcad templates to save layout and formatting information to re-use in worksh
you later create. When you create a Mathcad template file, the template will be i
manual mode if you previously removed the checkmark from Automatic Calculation 
on the Math  menu; otherwise it will be in automatic mode.

You may also change the calculation mode of a template file from automatic to ma
or vice versa. For example, to change the calculation mode of an existing Mathc
template file from automatic to manual, do the following:

■ Open the Mathcad template file, as described in the section “Worksheets and
templates” in Chapter 4.

■ Choose Automatic Calculation from the Math  menu. This command puts Math
cad into manual mode. The checkmark beside this menu item should now be 

■ Save the template file.

Thereafter, whenever you create a Mathcad worksheet based on this template, Ma
will be in manual mode.
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Disabling equations 

You can disable a single equation so that it no longer calculates along with other reg
in your worksheet, but you can still use Mathcad's equation editing, formatting, a
display capabilities.

To disable calculation for a single equation in your worksheet, without affecting t
calculation mode of the rest of the worksheet, follow these steps: 

■ Click on the equation you want to disable.

■ Choose Properties from the Format menu, and click on the Calculation tab.

■ Under “Calculation Options” place a check in the box next to “Disable Evaluatio

■ Mathcad shows a small rectangle after the 
equation to indicate that it is disabled. An 
example is shown at right.

You can edit a disabled equation just as you would any other equation. Howeve
disabled equation does not affect any other calculations, nor does it reflect change
make to other equations in the worksheet. 

To re-enable calculation for a disabled equation:

■ Click on the equation to select it.

■ Choose Properties from the Format menu, and click on the Calculation tab.

■ Under “Calculation Options” remove the check in the box next to “Disable Eva
ation.” 

Mathcad removes the small rectangle beside the equation.

Note: If you disable a plot or an output table, Mathcad freezes the display for the
or table. Changes you make to other parts of the worksheet will not affect the plo
table. If you move a disabled equation that happens to be displaying a result, the 
will disappear. If you move a graph, whatever is inside the graph will disappear.

Error messages 

Mathcad may encounter an error when evaluating an expression. If it does, it mark
offending expression with an error message and highlights the offending name o
operator in a different color (red). 
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Figure 7-12: A worksheet containing an error message and several undefined 
variables.

An error message is visible only when you click on the associated expression. F
7-12 shows how an error message looks when you click on an expression. You'll a
be able to get on-line help about the error message by clicking on it and pressin
[Shift ][F1]. 

Mathcad cannot process an expression containing an error. If the expression is 
definition, the variable or function it is supposed to define will remain undefined. T
can cause any expressions that reference that variable to be undefined as well. M
indicates undefined variables and functions by displaying their names in red. In t
example shown in Figure 7-12, an error in the definition of x1 causes the variable to be
undefined in three different places in the worksheet.

Note that in an expression in which zero is either a pre-factor or numerator (for exa
 or ), Mathcad computes the result as zero, without evaluating or chec

for errors in the x expression. 

Fixing errors 

If your worksheet contains several expressions with errors, as shown in Figure 7
this is what to do:

■ Determine which expression with an error is closest to the top of the workshe
This error is probably the cause of many of the other errors.

■ If necessary, click on the error and press [Shift ][F1] for help.

0 x⋅ 0 x⁄
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■ If you anticipate time-consuming calculations, switch to manual mode as descr
in “Controlling calculations” on page 150. This will allow you to make numero
changes without having to wait for Mathcad to recalculate. When you are read
recalculate, choose Calculate from the Math  menu.

Once you have determined which expression caused the error, edit that express
fix the error, or change the variable definitions that led to the error. When you clic
the expression and begin editing, Mathcad removes the error message. When yo
outside the equation (or in manual calculation mode, when you recalculate), Mat
recomputes the expression. If you have fixed the error, Mathcad then recompute
other expressions affected by the expression you changed.

Note that when you see an error message attached to an expression, it doesn't nec
mean that you should edit that expression. More often than not, the error arises 
result of functions or variables defined farther up in the worksheet. Edit these oth
definitions to fix the error. For example, in Figure 7-12, all five errors are caused 
division by zero. To fix all five error messages at once, change the definition for a as 
shown in Figure 7-13.

Figure 7-13: Changing the definition of the variable “a” fixes all errors at 
once.

A note about function definitions 

When you define a function, Mathcad does not try to evaluate it until you use it la
on in the worksheet. If there is an error, the use of the function is marked in error, 
though the real problem may be in the definition of the function itself. Figure 7-14
shows two examples of this.
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When a user-defined function is marked in error, be sure to check the function defin
to find the actual source of error. Note that the second example in shows a recur
definition generating a “stack overflow” error message. Although Mathcad suppo
recursive function definitions, as described in “Recursive function definitions” on p
142, you must supply an initial condition in your function definition that prevents t
recursion from going on forever.

Figure 7-14: When an error message points to a function, go back and check 
the way the function was defined. 
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